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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. TheTechnical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, theTechnical Support groupworkswithProductEngineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer onwhich theproblemoccurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

www.symantec.com/business/support/
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■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If yourSymantecproduct requires registrationor a licensekey, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs, DVDs, or manuals

www.symantec.com/business/support/
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Support agreement resources
If youwant to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

mailto:customercare_apac@symantec.com
mailto:semea@symantec.com
mailto:supportsolutions@symantec.com
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Introducing AdvancedDisk

This chapter includes the following topics:

■ About the AdvancedDisk option

■ New features and enhancements for NetBackup 7.5

About the AdvancedDisk option
The NetBackup AdvancedDisk storage option lets you use the disk storage that is
exposed to NetBackup as a file system for backups. Storage can be direct attached
storage (DAS), network attached storage (NAS), or storage area network (SAN)
storage. NetBackup aggregates the disks into pools of storage you can use for
backups. NetBackup manages the storage as logical entities (disk pools).

NetBackup requires exclusive access to the storage for capacitymanagement and
load balancing.

Figure 1-1 shows a media server and attached disks.

Figure 1-1 AdvancedDisk storage components

Disk volumes Network file system
mounts

NetBackup media servers function as
both storage servers and data movers

AdvDiskPool_Gold AdvDiskPool_Silver
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The NetBackup AdvancedDisk storage option provides the following benefits:

■ Is easy to deploy and use. NetBackup discovers the storage and uses familiar
NetBackup storage units and backup policies to use the storage.

■ Allows multiple file systems to be used in a single storage unit.

■ Allows user to increase storage unit capacity by adding disks. Only add the
capacity required, then update the NetBackup disk pools. Logical units of
storage span physical boundaries, so you donot have to create newNetBackup
storage units or change the backup policies.

■ Reduces the level of administrator attention. Automatic policies distribute job
load and intelligently manage capacity so that jobs do not fail because of out
of space conditions.

New features and enhancements for NetBackup 7.5
The following are new features and enhancements in the NetBackup 7.5 release
for AdvancedDisk:

■ Support for theCommon Internet File System is now included in theDiskPool
Configuration Wizard.
See “About AdvancedDisk file system requirements” on page 15.

■ Data encryption.
See “About data encryption for AdvancedDisk storage” on page 20.

Introducing AdvancedDisk
New features and enhancements for NetBackup 7.5
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Licensing AdvancedDisk

This chapter includes the following topics:

■ About the AdvancedDisk license key

■ Licensing AdvancedDisk

About the AdvancedDisk license key
AdvancedDisk is a feature that is licensed separately from base NetBackup. The
Flexible Disk Option license key activates AdvancedDisk.

You may have a single license key that activates both NetBackup and the Flexible
DiskOption. Alternatively, youmayhave one license key that activatesNetBackup
and another key that activates the Flexible Disk Option.

See “Licensing AdvancedDisk” on page 12.

If you remove the Flexible Disk Option license key or if it expires, the following
restrictions apply:

■ You cannot create the disk pools or the storage units that reference
AdvancedDisk disk pools.

■ NetBackup jobs that attempt to use the disk pools or the storage units that are
based on disk pools fail. The error message indicates that the feature is not
licensed.

NetBackup does not delete the disk pools or the storage units that reference the
disk pools. You can use them again if you enter a valid license key.

2Chapter



Licensing AdvancedDisk
Nospecial installation is required for theNetBackup components ofAdvancedDisk.
However, you must enter a license key. If you installed the license key when you
installed or upgraded NetBackup, you do not need to perform this procedure.

Enter the license key on the NetBackup master server. The following procedure
describes how to use theNetBackupAdministrationConsole to enter the license
key.

To license AdvancedDisk

1 To add a license to a specific server, select File > Change Server and then
select the server.

2 In the NetBackup License Keys dialog box, click New.

3 In the AddaNewLicenseKey dialog box, enter the license key and click Add
or OK.

4 Click Close.

5 Restart all the NetBackup services and daemons.

Licensing AdvancedDisk
Licensing AdvancedDisk
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Configuring AdvancedDisk

This chapter includes the following topics:

■ Configuring the AdvancedDisk option

■ About AdvancedDisk file system requirements

■ Configuring credentials for CIFS and disk storage units

■ About AdvancedDisk storage servers

■ About AdvancedDisk data movers

■ About AdvancedDisk preferred or required read servers

■ About data encryption for AdvancedDisk storage

■ About key management for AdvancedDisk encryption

■ Configuring the Key Management Service for AdvancedDisk encryption

■ Configuring an AdvancedDisk storage server

■ About AdvancedDisk disk pools

■ Configuring a CIFS disk volume for AdvancedDisk encryption

■ Configuring an AdvancedDisk disk pool

■ Configuring an AdvancedDisk storage unit

■ Creating a storage lifecycle policy

■ Creating a policy using the Policy Configuration Wizard

■ Creating a policy without using the Policy Configuration Wizard

3Chapter



Configuring the AdvancedDisk option
This section provides an overview of how to configure the NetBackup
AdvancedDisk option.

Table 3-1 describes the configuration tasks.

To configure a base NetBackup environment, see the following guides:

■ The NetBackup Administrator's Guide for Windows, Volume I.

■ The NetBackup Administrator's Guide for UNIX and Linux, Volume I.

Table 3-1 AdvancedDisk configuration tasks

SectionTaskStep

See “About AdvancedDisk file system
requirements” on page 15.

Learn about file system
requirements

Step 1

See “About AdvancedDisk storage servers”
on page 17.

See “About AdvancedDisk data movers”
on page 18.

Learn about storage servers
and data movers

Step 2

The Key Management Service is required if you
usedata encryption for theAdvancedDisk storage.

See “About data encryption for AdvancedDisk
storage” on page 20.

See “About key management for AdvancedDisk
encryption” on page 21.

See “Configuring the Key Management Service
for AdvancedDisk encryption” on page 22.

Optionally, configure theKey
Management Service

Step 3

See “Configuring an AdvancedDisk storage
server” on page 26.

Configure a storage serverStep 4

See “AboutAdvancedDisk disk pools” onpage 28.Learn about disk poolsStep 5

For theAdvancedDisk_cryptdisk type, youmust
configure CIFS volumes before you can add them
to the disk pool.

See “Configuring a CIFS disk volume for
AdvancedDisk encryption” on page 29.

Optionally, configure CIFS
disk volumes

Step 6

See “Configuring an AdvancedDisk disk pool”
on page 30.

Configure a disk poolStep 7

Configuring AdvancedDisk
Configuring the AdvancedDisk option
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Table 3-1 AdvancedDisk configuration tasks (continued)

SectionTaskStep

See “Configuring an AdvancedDisk storage unit”
on page 35.

Configure a storage unitStep 8

See “Creating a storage lifecycle policy”
on page 39.

Create a storage lifecycle
policy

Step 9

See “Creating a policy using the Policy
Configuration Wizard” on page 44.

See “Creating a policy without using the Policy
Configuration Wizard” on page 44.

Create a backup policyStep 10

About AdvancedDisk file system requirements
AdvancedDisk can read and write any nonshared file system that NetBackup
supports.However, AdvancedDisk is subject to anyoperating systemor file system
requirements or limitations. Requirements and limitations may exist beyond
those mentioned in this topic.

For supported file systems, see theNetBackupoperating systemcompatibility list
at the Symantec support Web site, as follows:

http://entsupport.symantec.com/

The following are additional requirements for file systems:

Windows Common Internet File System (CIFS) requirements:

■ You must configure two Windows services to use the same credentials.

See “Configuring credentials for CIFS and disk storage units” on page 16.

■ In theDiskPoolConfigurationWizard, youmust use theWindowsUniversal
Naming Convention to specify the CIFS volumes that you want to use for
AdvancedDisk disk pools. (Networked mapped devices are not visible to
Windows services; therefore, NetBackup cannot discover CIFS disk volumes.)

■ You cannot delete a disk pool that is created by specifying volumes (such as
for CIFS volumes). The disk pool exists until you delete its storage server.

CIFS

15Configuring AdvancedDisk
About AdvancedDisk file system requirements
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Network File System (NFS) requirements:

■ You must use manual mount points. Automatic mount and unmount can
change mount points, which may cause disk resources to be unavailable.

■ The NFS server that exports the mount points must be configured to allow
root access to the file systems.

■ NetBackup does not filter out common file system mount points, such as /
and /usr. Therefore, carefully choose the volumes to include in a disk pool.

Note: Symantec recommends that you do not span backup images across NFS
volumes in an AdvancedDisk disk pool. File system full conditions cannot be
detected adequately. Therefore, a disk pool based on NFS volumes should be
comprised of only one volume.

NFS

Disk pool configuration may affect how you configure your file systems.

See “Configuring an AdvancedDisk disk pool” on page 30.

Configuring credentials for CIFS and disk storage
units

For Common Internet File System (CIFS) storage with AdvancedDisk, two
NetBackup services on Windows computers require matching credentials.

The following NetBackup services on Windows media servers to which the CIFS
storage is attached must use the same credentials:

■ NetBackup Client Service
The NetBackup Client Service is either bpcd.exe or bpinetd.exe, depending
on NetBackup release level. Regardless of the binary file name, the service
requires the credentials.

■ NetBackup Remote Manager and Monitor Service
The NetBackup Remote Manager and Monitor Service binary file name is
nbrmms.exe.

The credentials must be valid Windows credentials that allow read and write
access to the storage. Configure the credentials on the media server or media
servers that have a file system mount on the CIFS storage.

If credentials are not configured,NetBackupmarks all CIFSAdvancedDisk storage
units that use the UNC naming convention as DOWN.

Configuring AdvancedDisk
Configuring credentials for CIFS and disk storage units
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To configure service credentials

1 In Windows, open the Services dialog box. How you open Services depends
on the Windows version.

2 Double-click the service name to open the Properties dialog box for the
service.

3 In the General tab, select the service that requires additional credentials.
Click Stop to stop the service.

4 Select the Log On tab.

5 Select This account and then enter the credentials. Click Apply.

6 Select the General tab.

7 Click Start to start the service.

8 Repeat the steps 2 to 7 for each service that requires additional credentials.

About AdvancedDisk storage servers
A storage server is a NetBackup media server that mounts the disk storage and
writes data to and reads data from the disk storage.

ForAdvancedDisk, NetBackupmedia servers function as both storage servers and
data movers.

See “About AdvancedDisk data movers” on page 18.

Multiple storage servers can exist. The storage servers share the storage equally.

If you configure more than one storage server, be aware of the following:

■ Each media server must mount the file systems of all the disk volumes within
a disk pool.

■ The mount points must be the same on each media server.
NetBackupdoes not validatemount points, so youmust ensure that themount
points are the same for eachmedia server. You alsomust ensure that themount
points are valid.

■ To obtain a consolidated list of disk volumes, NetBackup queries every media
server. For large sets of servers, queries may affect performance.

■ Disk volume status is monitored on a single media server. Which server
monitors the status can change. Therefore, a change in disk volumeavailability
on onemedia servermay not be reflected in the disk volume status NetBackup
reports.

Storage servers are either AdvancedDisk type or AdvancedDisk_crypt type.

17Configuring AdvancedDisk
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Whether or not you want to use encryption or specify storage server attributes
determines how you configure the storage servers.

See “About data encryption for AdvancedDisk storage” on page 20.

See “About AdvancedDisk preferred or required read servers” on page 18.

See “Configuring an AdvancedDisk storage server” on page 26.

About AdvancedDisk data movers
A data mover transfers data from primary storage (a NetBackup client) to
secondary storage during backups. It also can move data back to primary storage
during restores and fromsecondary storage to tertiary storage during duplication.

Youdonot configure datamovers separately. ForAdvancedDisk,NetBackupmedia
servers function as both storage servers and data movers. Data movers are
configured when you configure storage servers.

About AdvancedDisk preferred or required read
servers

When you configure a storage server, you can specify that you want it to be
preferred or required for restore jobs. You also can specifywhether a server should
be required for the read side of duplication jobs. These attributes can helpmanage
the restore and the duplication traffic.

Table 3-2 Preferred or required read server descriptions

DescriptionServer
attribute

The server is preferred for the read side of restore operations. You can
configure more than one server as preferred for restore.

If you configure preferred for restore but not required for restore,
NetBackup considers preferred storage servers for jobs first. If none are
available, NetBackup considers any configured storage server.

Normal NetBackup load balancing occurs among all storage servers
marked PrefRestore.

PrefRestore

Configuring AdvancedDisk
About AdvancedDisk data movers
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Table 3-2 Preferred or required read server descriptions (continued)

DescriptionServer
attribute

The server is required for the read side of restore operations. You can
configure more than one server as required for restore.

If you configure required servers for restore but not preferred servers,
jobs queue until a required server is available to execute the job. Other
servers are never considered for restore jobs. Normal NetBackup rules
for job retry apply.

If you configure both preferred and required storage servers and a
required server is not available, NetBackup considers preferred servers
for jobs. If none are available, jobs queue until a required or preferred
server is available. Other servers are never considered for restore jobs.

Normal NetBackup load balancing occurs for all required servers. Load
balancing does not occur between the required and preferred servers.

ReqRestore

The server is required for the read side of duplication operations. You
can configure more than one server as required for duplication.

If any server is configured as required for duplication, NetBackup
considers only required for duplication servers for jobs. If a required
server is unavailable, jobs queue until a required server is available to
execute the job. Normal NetBackup rules for job retry apply.

Required for duplication also applies to storage server allocation for
synthetic backup operations.

ReqDuplicate

Only the media servers that are configured in the storage unit are considered for
jobs. Therefore, if you configure a subset of the disk poolmedia servers in a storage
unit, NetBackup selects from those servers only.

If you use the preferred or required restore or duplication attributes for a storage
server, the following may occur:

■ A restore operation uses a storage server that does not have a PrefRestore
or ReqRestore attribute. Reasons may be as follows:

■ The destination disk pool does not include a storage server with a restore
or a duplication attribute.

■ A preferred or required storage server cannot be used because it is
unavailable (NetBackup considers it DOWN).

■ A restore or a duplication operation is queued.
The reason may be that a preferred or required storage server cannot be used
because it is unavailable (NetBackup considers it DOWN).
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If you do not configure preferred or required restore servers, NetBackup uses
normal criteria to select a media server for restore or duplication. (That is, if you
configure more than one storage server.)

Information about how NetBackup balances storage unit and media server load
is available.

See “Maximum concurrent jobs” in the following guides:

■ NetBackup Administrator’s Guide for UNIX and Linux, Volume I

■ NetBackup Administrator’s Guide for Windows, Volume I

You can use preferred or required restore servers rather than the Media host
override host property.

Information about the Media host override property is available.

See the following guides:

■ NetBackup Administrator’s Guide for UNIX and Linux, Volume I

■ NetBackup Administrator’s Guide for Windows, Volume I

To enable preferred or required servers for restore or duplication, do the following:

■ Upgrade the NetBackup master server and the NetBackup EMM server to
NetBackup 6.5.2 or later. (Normally, the master server and the EMM server
are on the same computer.)

■ Optionally, to enable command-line support on media servers, upgrade the
media servers that are used for AdvancedDisk operations to NetBackup 6.5.2
or later.
You do not have to upgrade the media servers. You can configure and manage
the restore and the duplication storage servers by invoking the commands on
the master server.

About data encryption for AdvancedDisk storage
You can encrypt your data on the storage. To use encryption, you must use the
AdvancedDisk_crypt type when you configure the storage servers and the disk
pools. You also must use the nbdevconfig command to configure the storage
servers and the disk pools.

NetBackup uses the Key Management Service to manage encryption keys. You
must configure KMS so that NetBackup can use AdvancedDisk encryption.

See “About key management for AdvancedDisk encryption” on page 21.
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After you configure KMS and AdvancedDisk_crypt storage servers and disk
pools, NetBackup uses encryption for backup jobs to those AdvancedDisk_crypt
disk pools.

AdvancedDisk encryption is supported on a subset of operating systems that are
supported byNetBackup. For supported systems, see theNetBackup compatibility
lists on the NetBackup support landing page.

ttp://www.symantec.com/

About keymanagement for AdvancedDisk encryption
NetBackup uses the Key Management Service (KMS) to manage the keys for the
data encryption. KMS is a NetBackup master server-based symmetric key
management service. To use encryption, you must first configure the Key
Management Service on the NetBackup master server.

Setting up the KMS database requires the following:

■ AHostMasterKeypassphrase and ID. TheKeyManagement Service can create
a random HMK passphrase for you.

■ A Key Protection Key passphrase and ID. The Key Management Service can
create a random KPK passphrase for you.

KMS for AdvancedDisk storage requires the following:

■ Each storage server and volume combination requires a key group. The key
group name is of the following format:
storage_server_name:volume_name

The following is the criteria for volume_name:

■ The volume_name must be the last directory name in the pathname to the
volume. For example, if the pathname is /mnt/disk/hdd1, the volume_name
must be hdd1.

■ The volume_namemust not contain forward or backward slash characters.
Therefore, onWindowshosts youmust specify a directory namenot a drive
letter.

■ Each key group you create requires a key record. KMS requires a passphrase
when you create the key record.
A key record name is optional. If you use a key record name, you can use any
name for the key record name. Symantec recommends that you use a
descriptive name.

See “Configuring the Key Management Service for AdvancedDisk encryption”
on page 22.
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More information about KMS is available.

See the NetBackup Security and Encryption Guide.

Configuring the Key Management Service for
AdvancedDisk encryption

To use AdvancedDisk encryption, you must first configure the Key Management
Service.

See “About key management for AdvancedDisk encryption” on page 21.

Table 3-3 KMS configuration tasks

InstructionsTaskStep

See “Setting up the KMS database for
AdvancedDisk encryption” on page 22.

Set up the KMS databaseStep 1

For AdvancedDisk, each storage server and
volume combination requires a key group.

See “Creating aKMSkey group forAdvancedDisk
encryption” on page 24.

Create the key groupsStep 2

Each key group requires a key record. The key
record contains the encryption key.

See “Creating aKMSkey record forAdvancedDisk
encryption” on page 25.

Create the key recordsStep 3

Setting up the KMS database for AdvancedDisk encryption
You must set up the Key Management Service database so that you can use
encryption for AdvancedDisk storage.
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To set up the KMS database

1 On the NetBackup master server, create the KMS database by running the
nbkms command with the -createemptydb option, as follows:

UNIX: /usr/openv/netbackup/bin/nbkms -createemptydb

Windows: install_path\Veritas\NetBackup\bin\nbkms.exe
-createemptydb

The following prompt appears:

Enter the Host Master Key (HMK) passphrase (or hit ENTER to use a

randomly generated HMK). The passphrase will not be displayed on

the screen.

Enter passphrase :

2 Enter a passphrase for the host master key (HMK) or press Enter to create a
randomly generated key.

After you enter the Host Master Key passphrase, the following prompt
appears:

An ID will be associated with the Host Master Key (HMK) just

created. The ID will assist you in determining the HMK associated

with any key store.

Enter HMK ID :

3 Enter an ID for the HMK. This ID can be anything descriptive that you want
to use to identify the HMK.

After you enter the Host Master Key ID, the following prompt appears:

Enter the Key Protection Key (KPK) passphrase (or hit ENTER to

use a randomly generated KPK). The passphrase will not be

displayed on the screen.

Enter passphrase :

4 Enter a passphrase for the key protection key.

After you enter the Key Protection Key passphrase, the following prompt
appears:

An ID will be associated with the Key Protection Key (KPK) just

created. The ID will assist you in determining the KPK associated

with any key store.

Enter KPK ID :
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5 Enter an ID for the KPK. The ID can be anything descriptive that you want
to use to identify the KPK.

6 Start the NetBackup KeyManagement Service on themaster server. You can
do so in the Activity Monitor of the NetBackup Administration Console.

After you start the service, the initial database setup is complete.

7 After you set up the database, create key groups for the volumes in the disk
pool.

See “Creating a KMS key group for AdvancedDisk encryption” on page 24.

Creating a KMS key group for AdvancedDisk encryption
A key group is a container for key records. A key group name for AdvancedDisk
is in the following format:

storage_server_name:volume_name

For AdvancedDisk, each storage server and volume combination requires a key
group. For example, if you have two storage servers and two volumes in the disk
pool, four key groups are required, as follows:

host1:volume1, host1:volume2, host2:volume1, and host2:volume2.

To create a KMS key group

1 On the master server, create a key group by using the nbkmsutil command
and the -createkg option. The following is an example of the command line:

UNIX:/usr/openv/netbackup/bin/admincmd/nbkmsutil -createkg -kgname

storage_server_name:volume_name

Windows: install_path\Veritas\NetBackup\bin\admincmd\nbkmsutil
-createkg -kgname storage_server_name:volume_name

The following is the criteria for volume_name:

■ The volume_namemust be the last directory name in the pathname to the
volume. For example, if thepathname is/mnt/disk/hdd1, thevolume_name
must be hdd1.

■ The volume_namemust not contain forward or backward slash characters.
Therefore, on Windows hosts you must specify a directory name not a
drive letter.

The following is a usage example:
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nbkmsutil -createkg -kgname StorageServerA.symantecs.org:AdvDisk

New Key Group creation is successful

2 After you create the key groups, create at least one key record for each group.

See “Creating a KMS key record for AdvancedDisk encryption” on page 25.

Creating a KMS key record for AdvancedDisk encryption
Each key group requires at least one key record. The key record contains the
encryption key itself and information about the key. The key is used to encrypt
and decrypt data.

A key record name is optional. If you use a key record name, you canuse anyname
for the key record name. Symantec recommends that you use a descriptive name.

Note: If you create more than one key record for a key group, only the last key
remains active.

To create a KMS key record

1 On the master server, create a key record by using the nbkmsutil command
and the -createkey option.

UNIX: /usr/openv/netbackup/bin/admincmd/nbkmsutil -createkey

-kgname storage_server_name:volume_name [-keyname keyname]

-activate

Windows: install_path\Veritas\NetBackup\bin\admincmd\nbkmsutil
-createkey -kgname storage_server_name:volume_name [-keyname

keyname] -activate

You are prompted to enter a passphrase.

The following is an example:

nbkmsutil -createkey -keyname dp_key -kgname StorageServerA.symantecs.org:AdvDisk -activate

Enter a passphrase: ********

Re-enter the passphrase: ********

New Key creation is successful

2 Enter a passphrase; this passphrase should differ from any passphrases you
entered already.
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Configuring an AdvancedDisk storage server
Configure in this context means to configure as a storage server a NetBackup
media server that can mount the storage.

See “About AdvancedDisk storage servers” on page 17.

Two methods exist to configure an AdvancedDisk storage server, as follows:

Symantec recommends that youuse thewizard to configure
the AdvancedDisk type of storage server.

See “To configure anAdvancedDisk storage server by using
the wizard” on page 27.

The Storage Server
Configuration Wizard.

Youmust use the command line to configure the following:

■ The AdvancedDisk_crypt type of storage server that
uses encryption.

For AdvancedDisk_crypt, you must specify the -st
option with a value of 5. (Usually, the -st option is
optional.)

See “About data encryption for AdvancedDisk storage”
on page 20.

■ Preferred or required attributes for the storage server.

See “About AdvancedDisk preferred or required read
servers” on page 18.

You also can use the command line to configure the
AdvancedDisk type of storage server.

See “To configure anAdvancedDisk storage server by using
the command line” on page 27.

The nbdevconfig
command.

When you configure an AdvancedDisk storage server, it also is configured as a
data mover.

See “About AdvancedDisk data movers” on page 18.

You can configure multiple storage servers for the same storage, as follows:

■ Invoke the wizard or the nbdevconfig command for each storage server that
you want to configure.

■ If you use the wizard, exit the wizard (on the Finished panel) after you create
each storage server except for the last one.

■ After you create the last storage server, do the following:

■ If you used theStorageServerConfigurationWizard, continue to theDisk
Pool Configuration Wizard.
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If you used the nbdevconfig command to configure AdvancedDisk_crypt
storage servers, use the nbdevconfig command to configure the disk pool.

See “Configuring an AdvancedDisk disk pool” on page 30.

To configure an AdvancedDisk storage server by using the wizard

1 Determine if the storage server is configured already.

See “Viewing AdvancedDisk storage servers” on page 50.

2 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Configure Disk Storage Servers.

3 Follow the wizard screens to configure a storage server.

To configure an AdvancedDisk storage server by using the command line

1 Determine if the storage server is configured already.

See “Viewing AdvancedDisk storage servers” on page 50.

2 Run the following command on the NetBackup master server or the media
server:

nbdevconfig -creatests -storage_server hostname -stype server_type

-st 5 -media_server hostname [-setattribute attribute]

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

See “AdvancedDisk storage server options” on page 27.

3 To verify that the storage server was configured correctly, run the following
command:

nbdevquery -liststs -u

The following is an excerpt of the command output that shows the proper
storage type for AdvancedDisk (Formatted Disk, Direct Attached):

Storage Server : AdvDiskServer.symantecs.org

Storage Server Type : AdvancedDisk_crypt

Storage Type : Formatted Disk, Direct Attached

State : UP

AdvancedDisk storage server options
The following are the nbdevconfig command options that are used to configure
storage servers.
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Table 3-4 Options to configure AdvancedDisk storage server

DescriptionOption

The name of the NetBackup media server that has a file system mount on the
storage.

-storage_server

storage_server

For AdvancedDisk with encryption, use AdvancedDisk_crypt, otherwise use
AdvancedDisk.

Note: If you specify AdvancedDisk_crypt as the -stype, you must specify an
-st value of 5 on the command line.

-stype server_type

A numeric value that specifies the storage server properties. For AdvancedDisk,
the default value is 5 (direct attached, formatted disk).

Note: For an AdvancedDisk_crypt -stype, you must specify -st 5 on the
command line.

-st storage_type

Use the same name as the storage server name.-media_server hostname

An attribute to apply to the storage server for the read side of restore or
duplication operations. The following are the attributes:

■ PrefRestore. The storage server is preferred for the read side of restore
operations.More thanone storage server canhave thePrefRestoreattribute.

■ ReqRestore. The storage server is required for the read side of restore
operations. More than one storage server can have the ReqRestore attribute.

■ ReqDuplicate. The storage server is required for the read side of duplication
operations. More than one storage server can have the ReqDuplicate
attribute.

See “About AdvancedDisk preferred or required read servers” on page 18.

-setattribute attribute

About AdvancedDisk disk pools
A disk pool represents disk volumes on the underlying disk storage. NetBackup
aggregates the disk volumes into pools of storage you can use for backups.

A disk pool is the storage destination of a NetBackup storage unit.

ForAdvancedDisk,NetBackupassumes exclusive ownership of the disk resources
that comprise the disk pool. If you share those resources with other users,
NetBackup cannotmanagedisk pool capacity or storage lifecycle policies correctly.

WhenNetBackup sends backupdata to a disk pool, NetBackup selects disk volumes
based on available capacity and predicted size of the backup. NetBackup tries to
write backup data to a single volume. If necessary, backup images span disk
volumes in a disk pool. Backup images do not span across multiple disk pools.
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Note: Symantec recommends that you do not span backup images across NFS
volumes in an AdvancedDisk disk pool. File system full conditions cannot be
detected adequately. Therefore, a disk pool based on NFS volumes should be
comprised of only one volume.

Symantec recommends that disk volume and disk pool names be unique across
your enterprise.

Disk pools are either AdvancedDisk type or AdvancedDisk_crypt type.

See “About data encryption for AdvancedDisk storage” on page 20.

For the AdvancedDisk_crypt disk type, you must configure the disk volumes
before you configure the disk pool.

See “Configuring a CIFS disk volume for AdvancedDisk encryption” on page 29.

See “Configuring an AdvancedDisk disk pool” on page 30.

Configuring a CIFS disk volume for AdvancedDisk
encryption

AdvancedDisk_crypt and CIFS only.

For theAdvancedDisk_cryptdisk type, youmust use theNetBackup nbdevconfig
command to specify each CIFS disk volume for the disk pool.

(Alternatively, for the AdvancedDisk disk type, the Disk Pool Configuration
Wizard lets you specify the CIFS volumes.)

Symantec recommends that disk volume and disk pool names be unique across
your enterprise.

You must first configure storage servers.

See “Configuring an AdvancedDisk storage server” on page 26.

To configure an AdvancedDisk disk volume by using the command line

1 On theNetBackupmaster server, configure the volumebyusing the following
command:

nbdevconfig -createdv -storage_server hostname -stype server_type

-dv disk_volume_name -dp disk_pool_name

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd
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The following describe the options:

Thenameof theNetBackupmedia server that has
a file system mount on the storage.

-storage_server hostname

For AdvancedDisk with encryption, use
AdvancedDisk_crypt, otherwise use
AdvancedDisk.

-stype server_type

The name of the disk volume; use UNC notation.-dv disk_volume_name

The name of the disk pool for the volume.-dp disk_pool_name

2 Repeat step 1 for each disk volume that you want to add.

Configuring an AdvancedDisk disk pool
Two methods exist to configure an AdvancedDisk disk pool, as follows:

Use thewizard to configure the AdvancedDisk type of disk
pool.

See “To configure an AdvancedDisk disk pool by using the
wizard” on page 31.

When you configure a storage server, thatwizard continues
to the disk pool wizard; therefore, you may not need to
invoke the disk pool wizard separately.

TheDiskPoolConfiguration
Wizard.

Use the command line if you configured an
AdvancedDisk_crypt type of storage server.

See “To configure anAdvancedDisk storage server by using
the command line” on page 27.

The nbdevconfig
command.

When you create an AdvancedDisk disk pool, you specify or select the following:

■ The NetBackup media servers that share the storage.
The media servers must be configured as storage servers. They also function
as data movers.
When you specify the storage servers, you associate them with the disk pool.
Only those storage servers can access the disk pool.
See “About AdvancedDisk storage servers” on page 17.

■ The disk volumes to include in the pool. If you use multiple storage servers
for the same disk pool, you must use the same mount point on all storage
servers for each volume.
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Normally, NetBackup discovers the volumes and you select the ones that you
want to include in the disk pool.However,NetBackup cannot discover Common
Internet File System (CIFS) disk volumes. (Networked mapped devices are not
visible toWindows services.) Therefore, youmust use theWindowsUniversal
Naming Convention to specify the CIFS volumes that you want to use for
AdvancedDisk disk pools.
For AdvancedDisk, the Disk Pool Configuration Wizard lets you specify the
CIFS volumes.
ForAdvancedDisk_crypt, youmustuse thenbdevconfig command to specify
the CIFS volumes.
See “Configuring aCIFSdisk volume forAdvancedDisk encryption” onpage 29.

■ The disk pool properties.
See “AdvancedDisk disk pool properties” on page 33.

Symantec recommends that disk volume and disk pool names be unique across
your enterprise.

You must first configure storage servers.

See “Configuring an AdvancedDisk storage server” on page 26.

To configure an AdvancedDisk disk pool by using the wizard

1 In the NetBackup Administration Console, in the left pane, select Media and
Device Management.

2 From the list of wizards in the right pane, click Configure Disk Pool and
follow the wizard instructions.

For help, see the wizard help.

To configure an AdvancedDisk disk pool by using the command line

1 On one of the storage servers, write the volumes that are available to a text
file by using the following command:

nbdevconfig -previewdv -storage_server hostname -stype server_type

> filename

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

The following describe the options:

Thenameof theNetBackupmedia server that has
a file system mount on the storage.

-storage_server hostname
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For AdvancedDisk with encryption, use
AdvancedDisk_crypt, otherwise use
AdvancedDisk.

-stype server_type

The name of the file into which to write the
volume information. Symantec recommends that
you use a name that describes its purpose.

> filename

2 Copy the file that you created in step 1 to the master server.

3 In a text editor, delete the line for each volume that you do not want to be in
the disk pool.

Each volume listed in the filemust be exposed to each AdvancedDisk storage
server on the same mount point.

4 Configure the disk pool by using the following command:

nbdevconfig -createdp -dp disk_pool_name -stype server_type

-storage_servers hostname... -dvlist filename [-reason "string"]

[-lwm low_watermark_percent] [-max_io_streams n] [-comment

comment] [-M master_server] [-reason "string"]

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

The name of the disk pool. Use the same name
that you used when you configured the disk
volumes.

-dp disk_pool_name

For AdvancedDisk with encryption, use
AdvancedDisk_crypt, otherwise use
AdvancedDisk.

-stype server_type

The name of each storage server that has a file
system mount on the storage. Specify all
NetBackupmedia servers that are storage servers
for this disk pool.

-storage_servers hostname

Thenameof the file that contains the information
about the volumes for the disk pool.

-dvlist filename

See “AdvancedDisk disk pool properties”
on page 33.

-hwm high_watermark
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See “AdvancedDisk disk pool properties”
on page 33.

-lwm low_watermark

See “AdvancedDisk disk pool properties”
on page 33.

-max_io_streams n

See “AdvancedDisk disk pool properties”
on page 33.

-comment comment

The name of the master server.-M master_server

The reason that you create the disk pool.-reason "string"

AdvancedDisk disk pool properties
Table 3-5 describes the disk pool properties.

Table 3-5 AdvancedDisk disk pool properties

DescriptionProperty

The disk pool name.Name

The storage server name. The storage server is the same as the NetBackup media server to
which the storage is attached.

Storage server

The disk volumes that comprise the disk pool.Disk volumes

The total amount of space available in the disk pool.Total size

The total raw, unformatted size of the storage in the disk pool.Total raw size

A comment that is associated with the disk pool.Comment
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Table 3-5 AdvancedDisk disk pool properties (continued)

DescriptionProperty

The High water mark setting is a threshold that triggers the following actions:

■ When an individual volume in the disk pool reaches the High water mark, NetBackup
considers the volume full.NetBackup chooses a different volume in the disk pool towrite
backup images to.

■ Whenall volumes in the disk pool reach theHighwatermark, the disk pool is considered
full. NetBackup fails any backup jobs that are assigned to a storage unit in which the
disk pool is full. NetBackup also does not assign new jobs to a storage unit in which the
disk pool is full.

■ NetBackup begins image cleanup when a volume reaches the High water mark; image
cleanup expires the images that are no longer valid. For a disk pool that is full, NetBackup
again assigns jobs to the storage unit when image cleanup reduces any disk volume's
capacity to less than the High water mark.

If the storage unit for the disk pool is in a capacity-managed storage lifecycle policy,
other factors affect image cleanup.

See the NetBackup Administrator's Guide for UNIX and Linux, Volume I.

See the NetBackup Administrator's Guide for Windows, Volume I.

The default is 98%.

High water mark

The Low water mark is a threshold at which NetBackup stops image cleanup.

TheLowwatermark setting cannot be greater than or equal to theHighwatermark setting.

The default is 80%.

Low water mark

Select this option to limit the number of read and write streams (that is, jobs) for each
volume in the disk pool. A job may read backup images or write backup images. By default,
there is no limit.

When the limit is reached,NetBackup chooses another volume, if available. If not available,
NetBackup queues jobs until a volume is available.

Too many jobs that read and write data may degrade disk performance because of disk
thrashing. (Disk thrashing is when the read and write heads move between the cylinders
excessively as they seek the data for competing jobs.)

Fewer streams can improve throughput, which may increase the number of jobs that
complete in a specific time period.

Limit I/O streams

Select or enter the number of read and write streams to allow per volume.

Many factors affect the optimal number of streams. Factors include but are not limited to
disk speed, CPU speed, and the amount of memory.

per volume
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Configuring an AdvancedDisk storage unit
Create one or more storage units that reference the disk pool.

The Disk Pool Configuration Wizard lets you create a storage unit; therefore,
you may have created a storage unit when you created a disk pool. To determine
if storage units exist for the disk pool, see theNetBackupManagement>Storage
> Storage Units window of the NetBackup Administration Console.

See “About AdvancedDisk storage unit recommendations” on page 37.

More information about storage units is available.

See the NetBackup Administrator's Guide for Windows, Volume I.

See the NetBackup Administrator's Guide for UNIX and Linux, Volume I.

To configure a storage unit from the Actions menu

1 In theNetBackupAdministrationConsole, in the left pane, selectNetBackup
Management > Storage > Storage Units.

2 Click Actions > New > Storage Unit.
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3 Complete the fields and set the options in the New Storage Unit dialog box.

See “AdvancedDisk storage unit properties” on page 36.

4 Click OK.

AdvancedDisk storage unit properties
The following are the configuration options for a disk pool storage unit.

Table 3-6 AdvancedDisk storage unit properties

DescriptionProperty

Enter a unique name for the new storage unit. The name can describe the type of storage.
The storageunit name is thenameused to specify a storageunit for policies and schedules.
The storage unit name cannot be changed after creation.

Storage unit name

Select Disk as the storage unit type.Storage unit type

Select AdvancedDisk for the disk type.Disk type

Select the disk pool that contains the storage for this storage unit.

All disk pools of the specified Disk type appear in the Disk pool list. If no disk pools are
configured, no disk pools appear in the list.

Disk pool

Specify the NetBackup media servers that can move data to and from the disk pool for
this storage unit. Only the media servers that are configured as storage servers appear
in the media servers list.

Specify the media server or servers as follows:

■ To allow any server in the media server list to access the disk storage (default), select
Use any available media server.

■ To restrict the media servers that can access the disk storage, select Only use the
following media servers. Then, select the media servers to allow. The selection list
includes only the media servers that are configured as storage servers for the disk
pool.

NetBackup selects the media server to use when the policy runs.

Media server
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Table 3-6 AdvancedDisk storage unit properties (continued)

DescriptionProperty

Specify the largest fragment size that NetBackup can create to store backups.

The default maximum fragment size for a disk storage unit is 524,288 megabytes. To
specify amaximumfragment size other than the default, enter a value from20megabytes
to 524,288 megabytes.

Backups to disk are usually fragmented to ensure that the backup does not exceed the
maximum size that the file system allows.

If an error occurs in a backup, the entire backup is discarded. The backup restarts from
the beginning, not from the fragment where the error occurred. (An exception is for
backups forwhich checkpoint and restart are enabled. In that case, fragments before and
including the last checkpoint are retained; the fragments after the last checkpoint are
discarded.)

Maximumfragmentsize

Specify the maximum number of jobs that NetBackup can send to a disk storage unit at
one time. (Default: one job. The job count can range from 0 to 256.) This setting
corresponds to theMaximumconcurrentwrite drives setting for aMediaManager storage
unit.

NetBackup queues jobs until the storage unit is available. If three backup jobs are
scheduled and Maximum concurrent jobs is set to two, NetBackup starts the first two
jobs and queues the third job. If a job contains multiple copies, each copy applies toward
the Maximum concurrent jobs count.

Maximum concurrent jobs controls the traffic for backup and duplication jobs but not
restore jobs. The count applies to all servers in the storage unit, not per server. If you
select multiple media servers in the storage unit and 1 for Maximum concurrent jobs,
only one job runs at a time.

The number to enter depends on the available disk space and the server's ability to run
multiple backup processes.

Warning: A Maximum concurrent jobs setting of 0 disables the storage unit.

Maximum concurrent
jobs

About AdvancedDisk storage unit recommendations
You can use storage unit properties to control howNetBackupmoves backup and
duplication data.

For example, you can configure a favorable client-to-server ratio for important
clients by using the storage unit Media server setting.

See “About configuring a favorable client-to-server ratio” on page 38.

You also can use the storage unit Maximum concurrent jobs setting to control
the backup or the duplication traffic that is sent to the media servers.
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See “About throttling traffic to the media servers” on page 38.

About configuring a favorable client-to-server ratio
For a favorable client-to-server ratio, you can use one disk pool and configure
multiple storage units to separate your backup traffic. Because all storage units
use the same disk pool, you do not have to partition the storage.

For example, assume that you have 100 important clients, 500 regular clients,
and four media servers. You can use two media servers to back up your most
important clients and two media servers to back up your regular clients.

The following example describes how to configure a favorable client-to-server
ratio:

■ Configure the media servers for AdvancedDisk and configure the storage.

■ Configure a disk pool.

■ Configure a storage unit for yourmost important clients (such as STU-GOLD).
Select the disk pool. Select Only use the following media servers. Select two
media servers to use for your important backups.

■ Create a backup policy for the 100 important clients and select the STU-GOLD
storage unit. Themedia servers that are specified in the storage unitmove the
client data to the storage server.

■ Configure another storage unit (such as STU-SILVER). Select the same disk
pool. Select Onlyuse the followingmedia servers. Select the other twomedia
servers.

■ Configure abackuppolicy for the500 regular clients and select theSTU-SILVER
storage unit. Themedia servers that are specified in the storage unitmove the
client data to the storage server.

Backup traffic is routed to the wanted data movers by the storage unit settings.

Note: NetBackup uses storage units for media server selection for write activity
(backups andduplications) only. For restores, NetBackup chooses among allmedia
servers that can access the disk pool.

About throttling traffic to the media servers
You can use the Maximumconcurrent jobs settings on disk pool storage units to
throttle the traffic to themedia servers. Effectively, this setting also directs higher
loads to specific media servers when you use multiple storage units for the same
disk pool. A higher number of concurrent jobs means that the disk can be busier
than if the number is lower.
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For example, two storage units use the same set of media servers. One of the
storage units (STU-GOLD) has a higher Maximum concurrent jobs setting than
the other (STU-SILVER). More client backups occur for the storage unit with the
higher Maximum concurrent jobs setting.

Creating a storage lifecycle policy
A storage lifecycle policy can be selected as the Policy storage within a backup
policy.

To create a storage lifecycle policy

1 In the NetBackupAdministrationConsole, select NetBackupManagement
> Storage > Storage Lifecycle Policies.

2 Click Actions > New > Storage Lifecycle Policy (UNIX) or Actions > New >
New Storage Lifecycle Policy (Windows).

3 In the New Storage Lifecycle Policy dialog box, enter a Storage lifecycle
policy name.

4 Select a Data classification. (Optional.)

5 Select theDuplicationjobpriority. This number represents the priority that
duplication jobs have in relationship to all other jobs. In duplication jobs,
NetBackup duplicates data from a backup destination to a duplication
destination within a lifecycle.

See “Storage Lifecycle Policy dialog box settings” on page 40.

39Configuring AdvancedDisk
Creating a storage lifecycle policy



6 Click Add to add operations to the SLP. The operations act as instructions
for the data.

See “Adding a storage operation to a storage lifecycle policy” on page 42.

7 Click OK to create the storage lifecycle policy.

Storage Lifecycle Policy dialog box settings
A storage lifecycle policy consists of one or more operations.

The New Storage Lifecycle dialog box and the Change Storage Lifecycle Policy
dialog box contains the following settings.

Figure 3-1 Configuration tab of the Storage Lifecycle Policy dialog box

Table 3-7 Configuration tab of the Storage Lifecycle Policy dialog box

DescriptionSetting

The Storage lifecycle policy name describes the SLP. The name cannot be modified
after the SLP is created.

Storage lifecycle policy
name
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Table 3-7 Configuration tab of the Storage Lifecycle Policy dialog box
(continued)

DescriptionSetting

The Data classification defines the level of data that the SLP is allowed to process.
The Data classification drop-down menu contains all of the defined classifications.
The Data classification is an optional setting.

One data classification can be assigned to each SLP and applies to all operations in
the SLP. An SLP is not required to have a data classification.

If a data classification is selected, the SLP stores only those images from the policies
that are set up for that data classification. If no data classification is indicated, the
SLP accepts images of any classification or no classification.

The Data classification setting allows the NetBackup administrator to classify data
basedon relative importance.A classification represents a set of backup requirements.
When data must meet different backup requirements, consider assigning different
classifications.

For example, email backup data can be assigned to the silver data classification and
financial data backup may be assigned to the platinum classification.

A backup policy associates backup data with a data classification. Policy data can be
stored only in an SLP with the same data classification.

Once data is backed up in an SLP, the data is managed according to the SLP
configuration. The SLP defineswhat happens to the data from the initial backup until
the last copy of the image has expired.

Data classification

ThePriorityforsecondaryoperations setting is the priority that secondary jobs (for
example, duplication jobs), have in relationship to all other jobs. Range: 0 (default)
to 99999 (highest priority).

For example, the Priority for secondary operations for a policy with a gold data
classification may be set higher than for a policy with a silver data classification.

The priority of the backup job is set in the backup policy on the Attributes tab.

Priority for secondary
operations

The Operations list contains all of the operations in the SLP. Multiple operations
imply that multiple copies are created.

The list also contains the columns that display information about each operation.
Note that not all columns display by default.

For column descriptions, see the following topic:

Operations

Enable Suspend secondary operations to stop the operations in the SLP.

A selected SLP can also be suspended from the Actions menu and then activated
again (Activate).

Suspend secondary
operations
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Table 3-7 Configuration tab of the Storage Lifecycle Policy dialog box
(continued)

DescriptionSetting

Use this button to see how changes to this SLP can affect the policies that are
associatedwith this SLP.Thebuttongenerates a report that displays on theValidation
Report tab.

This button performs the same validation as the -conflict option performs when
used with the nbstl command.

Validate Across Backup
Policies button

Use the arrows to indicate the indentation (or hierarchy) of the source for each copy.
One copy can be the source for many other copies.

Many operations can be hierarchical or non-hierarchical:

Arrows

Adding a storage operation to a storage lifecycle policy
Use the followingprocedure to add a storage operation to a storage lifecycle policy:

To add a storage operation to a lifecycle policy

1 In the NetBackupAdministrationConsole, select NetBackupManagement
> Storage > Storage Lifecycle Policies.

2 Click Actions > New > New Storage Lifecycle Policy (Windows) or Actions
> New > Storage Lifecycle Policy (UNIX).

3 Click Add to add operations to the SLP. The operations are the instructions
for the SLP to follow and apply to the data that is eventually specified in the
backup policy.

To create a hierarchical SLP, select an operation to become the source of the
next operation, then click Add.
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4 In theNewStorageOperationdialog box, select anOperation type. Thename
of the operation reflects its purpose in the SLP:

■ Backup

■ Backup From Snapshot

■ Duplication

■ Import

■ Index From Snapshot

■ Replication

■ Snapshot

5 Indicate where the operation is to write the image. Depending on the
operation, selections may include storage units or storage unit groups.

No BasicDisk, SnapVault, or disk staging storage units can be used as storage
unit selections in an SLP.

Note: In NetBackup 7.5, the Any_Available selection is not available for new
SLPs. In anupgrade situation, existing SLPs that useAny_Available continue
to work as they did before NetBackup 7.5. However, if the NetBackup
administrator edits an existing SLP, a specific storage unit or storage unit
group must be selected before the SLP can be saved successfully.

6 If the storage unit is a tape device or virtual tape library (VTL)., indicate the
Volume pool where the backups (or copies) are to be written.

7 Indicate the Media owner if the storage unit is a Media Manager type and
server groups are configured.

By specifying a Media owner, you allow only those media servers to write to
the media on which backup images for this policy are written.

8 Select the retention type for the operation:

■ Capacity managed

■ Expire after copy
If a policy is configured to back up to a lifecycle, the retention that is
indicated in the lifecycle is the value that is used. TheRetention attribute
in the schedule is not used.

■ Fixed

■ Maximum snapshot limit
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■ Mirror

■ Target retention

9 Indicate an Alternate read server that is allowed to read a backup image
originally written by a different media server.

10 Click OK to create the storage operation.

Creating a policy using the Policy Configuration
Wizard

The easiest method to set up a backup policy is to use the Policy Configuration
Wizard. This wizard guides you through the setup process by automatically
choosing the best values for most configurations.

Not all policy configurationoptions arepresented through thewizard. For example,
calendar-based scheduling and the Data Classification setting. After the policy
is created, modify the policy in the Policies utility to configure the options that
are not part of the wizard.

Use the following procedure to create a policy using the Policy Configuration
Wizard.

To create a policy with the Policy Configuration Wizard

1 In theNetBackupAdministrationConsole, in the left pane, clickNetBackup
Management.

2 In the right pane, click Create a Policy to begin the Policy Configuration
Wizard.

3 Click Next to start the wizard and follow the prompts.

Click Help on any wizard panel for assistance while running the wizard.

Creating a policy without using the Policy
Configuration Wizard

Use the following procedure to create a policy without using the Policy
Configuration Wizard.

To create a policy without the Policy Configuration Wizard

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 Type a unique name for the new policy in the Add a New Policy dialog box.
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3 If necessary, clear the Use Policy Configuration Wizard checkbox.

4 Click OK.

5 Configure the attributes, the schedules, the clients, and the backup selections
for the new policy.
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Managing AdvancedDisk

This chapter includes the following topics:

■ Managing AdvancedDisk storage servers

■ Managing AdvancedDisk disk pools

■ Monitoring AdvancedDisk storage capacity and usage

■ Monitoring NetBackup disk activity

■ Viewing disk reports

■ Displaying KMS key information for AdvancedDisk encryption

Managing AdvancedDisk storage servers
After you configure AdvancedDisk, you can perform various tasks to manage
storage servers.

See “Deleting an AdvancedDisk storage server” on page 47.

See “Determining AdvancedDisk storage server state” on page 48.

See “Removing anAdvancedDisk storage server fromdisk pool access” onpage 49.

See “Removing AdvancedDisk storage server attributes” on page 48.

See “Viewing AdvancedDisk storage servers” on page 50.

See “Viewing AdvancedDisk storage server attributes” on page 50.

Deleting an AdvancedDisk storage server
If you delete a storage server, NetBackup removes the storage server only from
your configuration.
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The media server is not deleted from your configuration. To delete the media
server, use the NetBackup nbemmcmd command.

If a disk pool is configured from the disk volumes that the storage servermanages,
you cannot delete the storage server.

Warning:Donot delete a storage server if its storage contains unexpiredNetBackup
images. If you do, data loss may occur.

To delete an AdvancedDisk storage server

1 In the NetBackup Administration Console, expand Media and Device
Management > Credentials > Storage Server.

2 On the Edit menu, select Delete.

3 Click Yes in the confirmation dialog box.

Determining AdvancedDisk storage server state
Use the NetBackup nbdevquery command to determine the state of an
AdvancedDisk storage server.

The following is the path to the nbdevquery command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

To determine AdvancedDisk storage server status

◆ Run the following command:

nbdevquery -liststs -stype AdvancedDisk -storage_server

server_name -U

The State field shows either UP or DOWN.

Removing AdvancedDisk storage server attributes
Use thenbdevconfig command to remove the following storage server attributes:

■ Preferred restore server (PrefRestore)

■ Required restore server (ReqRestore)

■ Required duplication server (ReqDuplicate)

See “About AdvancedDisk preferred or required read servers” on page 18.
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Attributes are added when you use the nbdevconfig command to configure a
storage server.

See “Configuring an AdvancedDisk storage server” on page 26.

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

To remove AdvancedDisk storage server attributes

◆ Run the following command on the NetBackup master server or on a storage
server:

nbdevconfig -changests -storage_server storage_server -stype

AdvancedDisk -clearattribute attribute

Removing an AdvancedDisk storage server from disk pool access
Use the nbdevconfig command to remove a storage server so that it no longer
can access a disk pool. If NetBackup jobs exist that use that storage server, you
cannot remove the storage server.

Warning: If you remove the only storage server, data may be lost. NetBackup
cannot access the disk pool and the backup images on the disk pool.

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd
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To remove an AdvancedDisk storage server from disk pool access

1 For every storage unit that specifies the storage server (media server) in Use
one of the following media servers, clear the check box that specifies the
media server.

This step is not required if the storage unit is configured to use any available
media server.

2 If only one storage server exists, change the state of all disk pools on the
array to DOWN. To do so, use the following command:

nbdevconfig -changestate -stype AdvancedDisk -dp disk_pool_name

-state DOWN

3 Remove the storage server. The following is the command syntax:

nbdevconfig -changedp -stype AdvancedDisk -dp disk_pool_name

-del_storage_servers storage_server

Viewing AdvancedDisk storage servers
Use the NetBackup Administration Console to view a list of storage servers
already configured.

To view AdvancedDisk storage servers

◆ In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Credentials > Storage Server.

The right pane, labeled All Storage Servers , shows all configured storage
servers. AdvancedDisk storage servers showAdvancedDisk in the DiskType
column.

Viewing AdvancedDisk storage server attributes
Use the NetBackup nbdevquery command to view the storage server attributes.

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd
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To view AdvancedDisk storage server attributes

◆ Run the following command on the NetBackup master server or a storage
server:

nbdevquery -liststs -storage_server storage_server -stype

AdvancedDisk –U

The following is example output:

Storage Server : advdsk_server.symantecs.com

Storage Server Type : AdvancedDisk

Storage Type : Formatted Disk, Direct Attached

State : UP

Flag : PrefRestore

This example output is shortened; more flags may appear in actual output.

Managing AdvancedDisk disk pools
After you configureAdvancedDisk, you canperformvarious tasks tomanage your
AdvancedDisk disk pools.

See “Adding volumes to an AdvancedDisk disk pool” on page 51.

See “Changing AdvancedDisk disk pool properties” on page 52.

See “Changing AdvancedDisk disk pool state” on page 53.

See “Changing AdvancedDisk disk volume state” on page 54.

See “Deleting an AdvancedDisk disk pool” on page 54.

See “Determining AdvancedDisk disk pool state” on page 55.

See “Determining AdvancedDisk disk volume state” on page 55.

See “Merging AdvancedDisk disk pools” on page 56.

See “Removing a volume from an AdvancedDisk disk pool” on page 57.

See “Viewing AdvancedDisk disk pools” on page 57.

Adding volumes to an AdvancedDisk disk pool
You can expand a disk pool’s capacity by adding disk volumes to the disk pool.
The names of the new volumes must differ from the names of the volumes in the
current disk pool.

The NetBackup storage units that use the disk pool use the additional storage
capacity automatically. You do not have to change the storage units.
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(By default, NetBackup automatically increases disk pool capacity if the capacity
of the underlying disk volumes increases. Similarly, NetBackup decreases the
capacity of a disk pool if the underlying disk volume capacity decreases.)

Table 4-1 Add volumes process for an AdvancedDisk disk pool

ProcedureTask

See “Configuring an AdvancedDisk disk pool”
on page 30.

Create a disk pool from the new
disk volumes on the storage
server.

When you merge the disk pools, specify the original
disk pool as the primary one. NetBackup deletes the
secondary disk pool after the merge.

See “Merging AdvancedDisk disk pools” on page 56.

Merge the disk pools.

Changing AdvancedDisk disk pool properties
You can change the storage server for a disk pool and change the properties of a
disk pool.

To add volumes to a disk pool, you must use a different procedure.

See “Adding volumes to an AdvancedDisk disk pool” on page 51.

To change disk pool properties

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Devices > Disk Pools.

2 In the right pane, select the disk pool that you want to change.
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3 Click Edit > Change.

4 In theChangeDiskPool dialog box, change storage servers or the properties.

See “AdvancedDisk disk pool properties” on page 33.

5 Click OK.

Changing AdvancedDisk disk pool state
Disk pool state is UP or DOWN.

To change the state to DOWN, the disk pool must not be busy. If backup jobs are
assigned to the disk pool, the state change fails. Cancel the backup jobs or wait
until the jobs complete.
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To change AdvancedDisk disk pool state

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Device Monitor.

2 Select the Disk Pools tab.

3 Select the disk pool.

4 Select either Actions > Up or Actions > Down.

Changing AdvancedDisk disk volume state
Use the NetBackup commands to change disk volume state. The state is UP or
DOWN.

To change the state to DOWN, the disk pool in which the volume residesmust not
be busy. If backup jobs are assigned to the disk pool, the state change fails. Cancel
the backup jobs or wait until the jobs complete.

NetBackup jobs still read from andwrite to a disk pool that has a downed volume,
but the downed volume is unavailable.

The nbdevconfig commandand the nbdevquery command reside in the following
directory:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\netbackup\bin\admincmd

To change the AdvancedDisk disk volume state

1 Determine the name of the disk volume. The following command lists all
volumes in the specified disk pool:

nbdevquery -listdv -stype AdvancedDisk -dp disk_pool_name

To display the disk volumes in all disk pools, omit the -dp option.

2 Change the disk volume state. The following is the command syntax:

nbdevconfig -changestate -stype AdvancedDisk -dp disk_pool_name

–dv vol_name -state state

The state is either UP or DOWN.

Deleting an AdvancedDisk disk pool
If you delete a disk pool, NetBackup removes it from your configuration.

If a disk pool is the storage destination of a storage unit, you must first delete the
storage unit.

Managing AdvancedDisk
Managing AdvancedDisk disk pools

54



Warning: Do not delete a disk pool that contains unexpired NetBackup images; if
you do, data loss may occur.

To delete an AdvancedDisk disk pool

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Devices > Disk Pools.

2 Select a disk pool

3 Click Edit > Delete.

4 In the Delete Disk Pool dialog box, verify that the disk pool is the one you
want to delete and then click OK.

Determining AdvancedDisk disk pool state
Disk pool state is UP or DOWN.

To determine AdvancedDisk disk pool state

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Device Monitor.

2 Select the Disk Pools tab.

3 The state is displayed in the Status column.

Determining AdvancedDisk disk volume state
Use the NetBackup nbdevquery command to determine the state of the volumes
in AdvancedDisk disk pools.

The following is the path to the nbdevquery command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd
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To determine AdvancedDisk disk volume state

1 Determine the name of the disk volume. The following command lists the
volumes in the specified disk pool:

nbdevquery -listdv -stype AdvancedDisk -dp disk_pool_name

To display the disk volumes in all AdvancedDisk disk pools, omit the -dp
option.

2 Display the volume state by using the following command:

nbdevquery -listdv -dv disk_volume -stype AdvancedDisk

The state is either UP or DOWN.

Merging AdvancedDisk disk pools
Use the NetBackup nbdevconfig command to merge existing disk pools.

NetBackup updates the catalog records to show the correct location of the backup
images in those disk pools.

If the secondary disk pool is referenced by storage units, you must first delete
those storage units.

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\netbackup\bin\admincmd

To merge AdvancedDisk disk pools

1 Change the state of each disk pool to DOWN.

See “Changing AdvancedDisk disk pool state” on page 53.

If backup jobs are assigned to a disk pool, the state change fails. Cancel the
backup jobs or wait until the jobs complete.

2 Merge the disk pools. The following is the command syntax. The primary disk
pool is the one you want to retain; nbdevconfig deletes the secondary disk
pool after the merge.

nbdevconfig –mergedps –stype AdvancedDisk -primarydp

disk_pool_name -secondarydp disk_pool_name

3 Change the state of the primary disk pool to UP.

See “Changing AdvancedDisk disk pool state” on page 53.
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Removing a volume from an AdvancedDisk disk pool
Use thenbdevconfig command to removeavolume fromadiskpool. The following
are the prerequisites:

■ NetBackup image fragments cannot exist on the disk volume.

■ NetBackup jobs cannot be active on the disk volume.

By default, NetBackup automatically decreases disk pool capacity if you remove
a disk volume.

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

To remove a volume from an AdvancedDisk disk pool

1 Change the disk volume state to DOWN.

See “Changing AdvancedDisk disk volume state” on page 54.

2 Change the disk pool state to DOWN.

See “Changing AdvancedDisk disk pool state” on page 53.

3 Remove the volume by using the nbdevconfig command. The following is
the command syntax:

nbdevconfig -deletedv -stype AdvancedDisk -dp disk_pool_name –dv

vol_name

4 Change the disk pool state to UP.

See “Changing AdvancedDisk disk pool state” on page 53.

Viewing AdvancedDisk disk pools
Use the NetBackup Administration Console to view configured disk pools.

To view disk pools

◆ In theNetBackupAdministrationConsole tree, in the left pane, selectMedia
and Device Management > Devices > Disk Pools.

The list appears in the right pane.

MonitoringAdvancedDisk storage capacity andusage
To monitor storage capacity and usage, see the following:

57Managing AdvancedDisk
Monitoring AdvancedDisk storage capacity and usage



The Disk Pools window displays a value that was stored
when NetBackup polled the disk pools. The value may not
be as current as the value that is displayed in the Storage
Server window.

To display the window, select Media and Device
Management > Devices > Disk Pools.

The NetBackup
AdministrationConsoleDisk
Pools window.

See “Viewing disk reports” on page 59.The NetBackup Disk Pool
status report.

The storage server view displays real-time values.

To display the window, select Media and Device
Management > Credentials > Storage Servers.

NetBackup Administration
Console Storage Server
window

The summary of active capacity-based license features in
the NetBackup License Keys dialog box. The summary
displays the storage capacity forwhich you are licensed and
the capacity used. It does not display the amount of physical
storage space.

To open the dialog box, select Help > License Keys in the
NetBackup Administration Console.

TheNetBackupLicenseKeys
dialog box.

The NetBackup OpsCenter also provides information about storage capacity and
usage.

See the NetBackup OpsCenter Administrator's Guide.

Monitoring NetBackup disk activity
You can monitor NetBackup disk-related activity and status by viewing the
NetBackup log files.

Some NetBackup commands or processes write messages to their own log files.
Other processes use Veritas unified log (VxUL) files. VxUL uses a standardized
name and file format for log files. An originator ID (OID) identifies the process
that writes the log messages.

Table 4-2 shows the NetBackup logs for disk-related activity.

The messages that begin with a sts_ prefix relate to the interaction with the
storage vendor software plug-in.Most interaction occurs on theNetBackupmedia
servers.
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Table 4-2 NetBackup logs

Processes that use the IDVxUL OIDActivity

Messages appear in the log files for the following
processes:

■ The bpbrm backup and restore manager

■ The bpdbm database manager

■ The bpdm disk manager

■ The bptm tape manager for I/O operations

N/ABackups and
restores

The nbjm job manager.117Backups and
restores

The nbemm process.111Device
configuration

The Disk Service Manager process that runs in the
Enterprise Media Manager (EMM) process.

178Device
configuration

The Storage Server Interface process that runs in the
Remote Manager and Monitor Service. RMMS runs
on media servers.

202Device
configuration

The Remote Disk Service Manager interface (RDSM)
that runs in theRemoteManager andMonitor Service.
RMMS runs on media servers.

230Device
configuration

To view and manage VxUL log files, you must use NetBackup log commands.
Information about how to use andmanage logs onNetBackup servers is available.

See the NetBackup Troubleshooting Guide.

Viewing disk reports
TheNetBackup disk reports include information about the disk pools, disk storage
units, disk logs, images that are stored on disk media, and storage capacity.

Table 4-3 describes the disk reports available.
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Table 4-3 Disk reports

DescriptionReport

The Images onDisk report generates the image list present on the
disk storage units that are connected to the media server. The
report is a subset of the Images on Media report; it shows only
disk-specific columns.

The report provides a summary of the storage unit contents. If a
disk becomes bad or if a media server crashes, this report can let
you know what data is lost.

Images on Disk

The Disk Logs report displays the media errors or the
informationalmessages that are recorded in theNetBackup error
catalog. The report is a subset of the Media Logs report; it shows
only disk-specific columns.

Disk Logs

The Disk Storage Unit Status report displays the state of disk
storage units in the current NetBackup configuration.

For disk pool capacity, see the disk pools window in Media and
Device Management > Devices > Disk Pools.

Multiple storage units can point to the same disk pool. When the
report query is by storage unit, the report counts the capacity of
disk pool storage multiple times.

Disk Storage Unit

TheDisk Pool Status report displays the state of disk pool storage
units. This report displays only when an Enterprise Disk Option
license is installed.

Disk Pool Status

To view disk reports

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Reports > Disk Reports.

2 Select the name of a disk report.

3 In the right pane, select the report settings.

4 Click Run Report.

Displaying KMS key information for AdvancedDisk
encryption

You can use the nbkmsutil command to list the following information about the
key groups and the key records:

■ Key groups
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See “To display KMS key group information” on page 61.

■ Keys
See “To display KMS key information” on page 62.

Note: Symantec recommends that you keep a record key information. The key
tag that is listed in the output is necessary if you need to recover keys.

the following are the directories in which the nbkmsutil command resides:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\Veritas\NetBackup\bin\admincmd

To display KMS key group information

◆ To list all of the key groups, use the nbkmsutil with the -listkgs option.
The following is an example:

nbkmsutil -listkgs

Key Group Name : StorageServerA.symantecs.org:AdvDisk

Supported Cipher : AES_256

Number of Keys : 1

Has Active Key : Yes

Creation Time : Wed Nov 30 16:53:48 2011

Last Modification Time: Wed Nov 30 16:53:48 2011

Description : -
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To display KMS key information

◆ To list all of the keys that belong to a key group name, , use the nbkmsutil
with the -listkgs and -kgname options. The following is an example:

nbkmsutil -listkeys -kgname StorageServerA.symantecs.org:AdvDisk

Key Group Name : StorageServerA.symantecs.org:AdvDisk

Supported Cipher : AES_256

Number of Keys : 1

Has Active Key : Yes

Creation Time : Wed Nov 30 16:53:48 2011

Last Modification Time: Wed Nov 30 16:53:48 2011

Description : -

Key Tag : 867d710aa7f4c64dcdd2cec6...cced0c831c1812c510acd05

Key Name : dp-key

Current State : ACTIVE

Creation Time : Wed Nov 30 17:06:26 2011

Last Modification Time: Wed Nov 30 17:06:26 2011

Description : -

Number of Keys: 1
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Toubleshooting
AdvancedDisk

This chapter includes the following topics:

■ AdvancedDisk troubleshooting

■ Resolving an incorrect storage type problem

AdvancedDisk troubleshooting
The following may help you troubleshoot AdvancedDisk:

Table 5-1 AdvancedDisk troubleshooting

SolutionProblem

If NetBackup cannot access the storage, one possible cause is that the storage server
was created with the incorrect nbdevconfig storage type (-st) value. An
AdvancedDisk storage server-st value is 5 (formatted disk, directly attached); values
other than 5 are incorrect.

More procedural information is available about resolving this problem.

See “Resolving an incorrect storage type problem” on page 64.

Unable to access storage

AdvancedDisk does not support Common Internet File System (CIFS). If you try to
configure multiple storage servers, NetBackup returns the following message:

DSM does not support to use multiple Windows Storage Servers

for server type: AdvancedDisk.

Multiple storage servers on
Windows

If a volume becomes unmounted, NetBackup changes the volume state to DOWN.
NetBackup jobs that require that volume fail.

To change the volume state to UP, mount the file system

Volume state changes to
DOWN when volume is
unmounted
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Table 5-1 AdvancedDisk troubleshooting (continued)

SolutionProblem

If recovery mechanisms do not protect a disk that fails, the backup images on that
disk are lost. Operating system read and write errors may occur for the volume that
represents the disk. NetBackup cannot use that volume because of the errors, and
NetBackup jobs may fail.

To prevent NetBackup from trying to read fromorwrite to the disk, youmust change
the volume state to DOWN in NetBackup. If the volume represents other disks that
still function, those disks are not available because the volume state is DOWN. You
may be able to read from the volume by mounting it manually. If so, you may be able
to recover image fragments from any disks that did not fail.

If you replace a failed disk, you can use the same mount point for the replacement
disk. Change the volume state to UP, and NetBackup uses that volume again.

Any valid backup images on that volume are available for restores.

Disk failure - AdvancedDisk

Resolving an incorrect storage type problem
First determine the storage server value to verify that the storage server was
created with the incorrect nbdevconfig storage type value. Then proceed to
resolving the problem if necessary.

To determine the storage server value

◆ Invoke the following command on the master server or a media server that
functions as a storage server:

The following output shows an incorrect value for AdvancedDisk:

Storage Server : halo

Storage Server Type : AdvancedDisk

Storage Type : Formatted Disk, Network Attached

To resolve an incorrect storage type problem

1 Delete all disk pools that use the storage server.

2 Delete the storage server.

3 Reconfigure the storage server.

4 Recreate the disk pools.

5 If necessary, specify the new disk pools in the storage units.

If you recreated the disk pools with the same names as the ones you deleted,
this step is not necessary.
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See “AdvancedDisk troubleshooting” on page 63.
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